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PREFACE 
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Signaling Incorporated. Where furnished with a proposal, the recipient 
shall use it solely to evaluate the proposal. Where furnished to customer, it 
shall be used solely for the purposes of inspection, installation or 
maintenance. Where furnished to a supplier, it shall be used solely in the 
performance of the contract. The information shall not be used or 
disclosed by the recipient for any other purposes whatsoever. 
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ABOUT THE MANUAL 

This manual is intended to provide the necessary information to maintain and ensure 
proper operation of the Maintenance Management System (MMS) for Alstom Vital 
Processor Interlocking Systems (VPI®, VPI® II, iVPI). 

The information in this manual is arranged into sections. The title and a brief description 
of each section follow: 

Section 1 – GENERAL DESCRIPTION: This section provides general information on 
the components of the Maintenance Management System (MMS).  

Section 2 – OPERATION: This section provides information on the typical use and 
operation of the Maintenance Management System (MMS).  

Section 3 – MMS EDITOR: This section describes the use of the Maintenance 
Management System (MMS) Editor software program. 

Section 4 – MMS RUNTIME: This section contains describes the use of the 
Maintenance Management System (MMS) Runtime software program. 

Section 5 – SYMBOLS: This section describes the layout symbols used in the MMS 
programs. 

Appendix A – COMMUNICATIONS: This section contains block diagrams describing 
Maintenance Management System (MMS) communications. 
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MANUAL SPECIAL NOTATIONS 

In the Alstom manuals, there are three methods used to convey special informational 
notations to the reader. These notations are warnings, cautions, and notes. Both 
warnings and cautions are readily noticeable by boldface type two lines beneath the 
caption. 

Warning 

A warning is the most important notation to heed. A warning is used to tell the reader 
that special attention needs to be paid to the message because if the instructions or 
advice is not followed when working on the equipment then the result could be either 
serious harm or death. The sudden, unexpected operation of a switch machine, for 
example, or the technician contacting the third rail could lead to personal injury or death. 
An example of a typical warning notice follows: 

WARNING 

DISCONNECT MOTOR ENERGY WHENEVER WORKING ON SWITCH 
LAYOUT OR SWITCH MACHINE. UNEXPECTED OPERATION OF 
MACHINE COULD CAUSE INJURY FROM OPEN GEARS, ELECTRICAL 
SHOCK, OR MOVING SWITCH POINTS. 

Caution 

A caution statement is used when failure to follow the recommended procedure could 
result in loss or alteration of data. A typical caution found in a manual is as follows: 

CAUTION 

Changing session date and time to earlier values may affect the ability of 
the History Window to store data correctly. 

Note 

A note is normally used to provide minor additional information to the reader to explain 
the reason for a given step in a test procedure or to just provide a background detail. An 
example of the use of a note follows: 

NOTE 

A capacitor may be mounted on the circuit board with a RTV adhesive. 
Use the same color RTV. 
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1. SECTION 1 – GENERAL DESCRIPTION 

1.1. SCOPE OF MANUAL 

This manual provides the necessary information to maintain and ensure proper 
operation of the Maintenance Management System (MMS) for Alstom Vital Processor 
Interlocking Systems (VPI®, VPI® II, iVPI). 

NOTE 

Whenever text applies to VPI®, VPI® II, and iVPI, the generic term VPI is 
used. If something is exclusive to one of the three systems, it is specified. 

1.2. GENERAL 

This section briefly describes the components and physical characteristics of the 
Maintenance Management System (MMS). 

NOTE 

The individual who installs MMS software must have administrator rights 
to the PC or laptop intended for use. 

1.3. MAINTENANCE MANAGEMENT SYSTEM 

Maintenance Management System (MMS) is a graphical Diagnostic and Maintenance 
Application that uses a graphical Track Layout to dynamically record and display the 
VPI diagnostic status, the status of linked VPI variables and play recorded data. 

Additional tools are available to manage diagnostics, configuration, event and data logs, 
schedule maintenance tasks and view, record, and play recorded VPI application 
variable data. 

MMS consists of two programs: 

• MMS Editor is used to graphically create the MMS Project  

• MMS Runtime is used to connect to VPI Systems and graphically display runtime 
information 



General Description 

P2509, Rev. Jan/09 1–2 Alstom Signaling Inc. 

1.4. REQUIREMENTS / FEATURES 

Table 1–1. Minimum PC Requirements 

Component Requirement 

OS Windows™ NT 4.0 SP 6, Windows™ 2000, Windows™ XP 
RAM 256 Meg 
CPU Pentium II or compatible 

Hard Disk 500 Meg available 
Input Device one of: Touch screen, Mouse, Trackball, Joystick  

and  a Keyboard 
Display SVGA (800 x 600) 
Ports one serial communication (RS-232 or USB) 
Other 1.44 Diskette or CD-ROM 

Table 1–2. Control System Component Requirements 

Component Requirement 

VPI Application  Must be created using VPI® application built with CAAPE version 
3A or later 

CSEX2 Board* 
or 

CSEX2 or CSEX3 used in VPI® Systems 

CSEX3 Board* 
or 

CSEX3 used in VPI® and VPI® II Systems 

NVSP Board NVSP Board used in iVPI Systems 
 
* Does not support CSE or CSEX1 boards. 
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1.5. GLOSSARY OF TERMS 

Table 1–3. Glossary of Terms 

Term Definition 

Application Explorer Accesses the selected System's variable data obtained 
through the diagnostic ports. Multiple logic, message, or I/O 
variables can be viewed in near real time. Variables are 
displayed using their assigned names and their current 
Boolean or integer values. Application logic statements can 
be displayed including the current values of the variables 
used to generate the statements. Datalogged variable data 
can be displayed using the playback feature. 

CAAPE Alstom’s Computer-Aided Application Programming 
Environment software package converts Boolean 
expressions into operating instructions for the VPI 
microprocessor to generate interlocking logic configured to 
meet the needs of the particular installation. 

Communication Explorer Provides access to serial ports through VT100. Display 
network statistics for networked connections. 

Configuration Manager Reports the expected and actual configuration items for 
each Application of the selected System. Both hardware 
and firmware items can be reported. 

Control System Hardware device connected to MMS Runtime Computer. 
Currently only VPI Systems are supported. 

Control Variable Data received by the VPI (MMS → VPI). 
CPU II Central Processing Unit II board used in the VPI® II Vital 

processor. 
CPU/PD Central Processing Unit/Polynomial Divider board used in 

the VPI® Vital processor. 
CSEX A family of non-vital communications and I/O control 

boards, including CSEX, CSEX2, and CSEX3 used in VPI® 

and VPI ® II systems. 
Data Log MMS Runtime events, System status, Diagnostics and VPI 

Data Logs saved in the MMS database. 
Drawing Area The Layout area of the MMS Editor where the location 

model is created. This is where symbols are placed and 
connected. 

HHT Hand Held Terminal; a simple text-based diagnostic display 
device. 
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Table 1–3. Glossary of Terms (Cont.) 

Term Definition 

Import Wizard A set of dialogs that guide a user through the steps 
necessary to place VPI information into the MMS Project 
database. 

Indication Variable Data sent by the VPI (VPI → MMS). 
iVPI Integrated Vital Processor Interlocking, an Alstom vital 

wayside control system. 
LCS file The compiler’s report file for a non-vital application (.lcs). 
Log Manager Handles the retrieval of VPI Data logs and the archival and 

display of all log data. 
LVC file The compiler’s report file for a vital processor application 

(.lvc). 
MAC port Maintenance ACcess Port; a port used to access diagnostic 

data. 
MMS Maintenance Management System. 
MMS Editor An application used to create MMS Project databases. 
MMS Event Log VPI Control and Indication data is recorded as MMS Event 

Log data. 
MMS Runtime An application used to communicate with Control Systems 

to provide, record, and play health, indication, and log 
information. 

Maintenance Diagnostics Graphical display of control system hardware status and 
diagnostic data. 

Vital Processor Board A board responsible for the VPI system non-vital 
processing: CSEX, CSEX2, CSEX3, NVSP. 

NVSP Non-Vital System Processor non-vital communications and 
I/O control board used in iVPI systems. 

Session The period of time MMS Runtime is operational; a new 
session log is created each time MMS Runtime is started. 

Status Bar MMS Runtime information is displayed as an expandable 
text list; the last 50 items are displayed with their associated 
time stamps. 

Symbol A graphical object that represents a field device. 
Task Scheduler A basic calendar to do list allowing a user to control 

maintenance tasks. 
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Table 1–3. Glossary of Terms (Cont.) 

Term Definition 

Track Layout The graphical model of a location. 
VDP Vital Diagnostic Protocol; a means of routing Vital 

processor diagnostic data through the diagnostic screens of 
a non-vital processor board. 

Vital Processor Board A board responsible for the VPI system non-vital 
processing: CPU/PD, CPU II, VSP 

VPI® Vital Processor Interlocking, an Alstom vital wayside control 
system. 

VPI® II Vital Processor Interlocking II, an Alstom vital wayside 
control system. 

VPI Data Log A collection of data retrieved from VPI CSEX Data Logger; 
the VPI CSEX Data Logger must be enabled and the data 
retrieved (see Log Manager). 

VSP Vital System Processor board (used in iVPI systems). 
VT100 Emulation of the DEC VT100 terminal protocol, including 

escape sequences for positioning and other uses. 
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1.6. CONTROL SYSTEM  

The VPI system is the control system supported by the MMS.  

A VPI system is generally comprised of one Vital processor board which coordinates the 
vital aspects of system operation and up to four non-vital processor boards. A non-vital 
processor board coordinates non-vital communications and handles non-vital I/O. Non-
vital only VPI systems containing only non-vital processor boards are also feasible. 

1.6.1. VPI Application 

Various VPI boards contain user programming that has been developed specifically for 
the location where the system is installed. The programming for a particular board is 
called an application. Each application includes logic statements that control the board's 
behavior. Logic statements manipulate variables, which are memory locations 
containing some discrete piece of information such as the status of an I/O port or a 
message bit. The most common logic statement is the Boolean equation, which logically 
combines the values of several variables to get a single True or False value and then 
assigns that value to one or more results. Vital processor boards are capable of 
processing only Boolean equations. Non-vital processor boards are also capable of 
processing integer equations as well as more complex statements such as subroutines 
and IF/ELSE. 

The application programming for a board is produced by compiling graphical or text 
based input files using software tools contained in the Computer-Aided Application 
Programming Environment (CAAPE). The compile process of the CAAPE optionally 
produces a report file which includes, among other things, a symbol table mapping 
memory locations to variable names and a logic section listing the logic statements in 
the application. Report files for Vital processor applications have an "LVC" extension; 
report files for non-vital processor applications have an "LCS" extension. 
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1.6.2. VPI Communication Ports 

Boards in the non-vital processor family produce diagnostic data that can be accessed 
through the MAC serial port by a series of menu-driven screens which can be displayed 
on a VT100 video terminal or an equivalent terminal emulator program. These boards 
can also produce real-time variable status data in a format compatible with MMS 
Runtime but is not directly displayable on a video terminal. In addition, serial ports using 
the DT8 Sync protocol or network diagnostic ports with a Panel message can be 
connected to interface with MMS Runtime to provide control and indication data. MMS 
Runtime can also use a serial or network diagnostic port for Data Log retrieval. 

The Vital processor board in a VPI provides diagnostic information in a text-based query 
/ response format that was originally meant for viewing with a hand held terminal. Newer 
versions of VPI system software also have a Vital Diagnostic Protocol (VDP) option that 
can route diagnostic information from the Vital processor board either through a serial 
port or through dual-ported random access memory (RAM) to the non-vital processor 
board and displayed through the non-vital processor board's diagnostic screens. 
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1.7. MMS EDITOR 

MMS Editor is used to:  

• Graphically model a given location. 

• Gather VPI application information. 

• Link symbol parameters to VPI variables for each graphical element. 

• Create an MMS Project database for use by MMS Runtime. 

The model of the plant is entered through the user-friendly Track Layout environment, 
using symbols representing track circuits, switches, signals, timers, and other layout 
hardware. 

The Import Wizard function guides the user to easily enter VPI configuration data into 
the MMS Project database. Individual Symbol parameters can be linked to VPI variables 
by the “drag and drop” of VPI variable names into the parameter tables. 

See Section 3, MMS Editor for a detailed explanation of how to use the MMS Editor to 
create an MMS Project. 

1.7.1. MMS Projects 

MMS Projects provides a variety of standard features: 

• Iconic representation of Control System status 

• Symbol parameter states graphically displayed and recorded 

• Board level diagnostics w/ solution guidelines 

• VPI vital and non-vital variable states displayed; can be recorded [up to 128 vital 
variables per Application (see Table 1–4); up to 128 non-vital variables per 
Application] 

• VPI Application logic display 

• VPI Data log retrieval; play of Data logs and recorded data; Log reports 

• VPI Configuration reports 

• To Do list for task scheduling 

• Embedded VT100 terminal emulator for serial ports 
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Additional features are available for newer VPI and CAAPE software versions, as 
summarized in Table 1–4. 

Table 1–4. MMS Projects Features Available with Specific VPI and/or CAAPE Software 

Feature Requirement 

View up to 16 vital variable states at one time 
in Application Explorer 

VPI® CPU/PD system software version 
40025-329 or later 
AND  
CAAPE version 4F or later 

View up to 64 Vital variable states at one 
time in Application Explorer 

VPI® CPU/PD system software version 
40025-404 or later 
AND  
CAAPE version 6 or later 
AND  
MMS version 2.0 or later 

View up to 128 Vital variable states at one 
time in Application Explorer 

VPI® II (CPU II) and iVPI (VSP) using 
Ethernet 
AND  
CAAPE version 8 or later 
AND  
MMS version 3.0 or later 

View up to 128 non-vital variable states at 
one time in Application Explorer 

iVPI (NVSP) using Ethernet 
AND  
CAAPE version 8 or later 
AND  
MMS version 3.0 or later 

Gather system status, diagnostics and vital 
variable state information through Vital 
Diagnostic Protocol 

VPI® CPU/PD system software version 
40025-329 or later 
AND 
CAAPE version 4F or later 

View VPI signature and shadow data in the 
Configuration Manager 

CAAPE version 4C or later 
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1.8. MMS RUNTIME 

MMS Runtime  

• Communicates with control systems (VPI Systems) through  

− Serial ports using  

• Hand-Held-Terminal (HHT) 

• Maintenance Access (MAC) 

• DataTrain VIII (DT8) protocol 

− Ethernet ports using Maintenance ACcess (MAC-TCP)  

• Uses a graphical point and click interface, eliminating the need to know command 
sets for each protocol. Displayed graphical symbols change state based on the 
linked control system variable data.  

• Continuously monitors the health of each connected control system. If a problem is 
identified, diagnostic information is requested and logged. 

• Displays information on designated pages: 

− Maintenance Diagnostic page - displays recorded diagnostic data: board level 
VPI diagnostic information along with troubleshooting and suggested solutions. 
Diagnostics can be filtered, cleared and history viewed. 

− Application Explorer page - displays variable states and equation logic for tracing 
possible problems. Variable state data can be recorded to play later. Data played 
later, variable state as well as VPI CSEX log data, is displayed in a timing 
diagram format. 

− Log Manager page - retrieves VPI CSEX data logs. These logs can be retrieved 
manually or automatically as a timed task. Creates reports of MMS events or 
data logs. 

− Configuration Manager page - displays control system hardware and firmware 
configuration information. 

− Task Scheduler page - provides a calendar based To Do list. 

− Communication Explorer page - a VT100 terminal emulator for those users who 
prefer command line formats with capture and macro support. Also displays 
network statistics. 

• Displays recorded indications on the Track Layout using the playback feature.  



General Description 

P2509, Rev. Jan/09 1–11 Alstom Signaling Inc. 

MMS Runtime uses the data provided in an MMS Project database created with MMS 
Editor. This database contains data describing the plant model and connected Control 
Systems. 

Control Systems are connected through serial and/or Ethernet ports to the MMS 
Runtime computer, allowing data to be transferred. Controls and indications, control 
system health, application equation and variable data, configuration information, and 
data log data can be transferred.  

The Control System information includes: 

• physical hardware layout and identification 

• type of system / application 

• variable data  

• equation logic data  

• serial port connection type and settings 

• network connection type and settings 

If the VPI Data Logger is configured to log the MMS port data, then the VPI logged data, 
once retrieved, can be displayed on the Track Layout using the playback feature. Any 
other logged data, once retrieved, can be displayed through the Application Explorer’s 
timing diagram. 

See Section 2 for an overview of MMS Runtime operation. See Section 4, MMS 
Runtime for a detailed explanation of how to access and use the data in an MMS 
Project. 
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2. SECTION 2 – OPERATION 

2.1. GENERAL 

This section contains typical operating information on the Maintenance Management 
System (MMS) for the Alstom VPI System.  

2.2. OPERATION 

Most maintenance personnel access the MMS to monitor or investigate their system. In 
this case, an application engineer has already created the MMS Project file for the 
location using MMS Editor and the user runs the MMS Runtime portion of the software 
to access recorded or live data.  

This Section describes launching MMS Runtime and the various screens it displays. 
Section 3 describes the use of MMS Editor in detail, while Section 4 describes the use 
of MMS Runtime in detail, including how to connect to a VPI System. 
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2.2.1. Starting MMS Runtime 

If the VPI System(s) is not already connected to the PC or laptop containing MMS 
software make the serial/network connections between the VPI System(s) and the PC.  

If MMS Runtime is not already running from the PC Start menu choose  
Programs->Alstom Maintenance Management System->Runtime. 

The first time the MMS Runtime is launched the screen prompts for a Project location. If 
the software has been used in the past, the last project viewed is displayed. Another 
Project can be selected from the Main Screen, see Figure 2–1.  

 

Figure 2–1. MMS Launch 

See Section 4.4.1. for additional information regarding what is visible when the software 
launches and how to choose a project. 

CONTROL SYSTEMS ICON 
Indicates VPI System Status: 
green frame – normal 
yellow frame – warning  
red frame – error  
blue frame with "?" – unknown 

If The Location Project (Data) 
Required Is Not Visible,  
Go To SETTINGS > PROJECTS To 
Select A Different Project. 
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2.2.2. Main Screen  

To display system control system status, control data, and indication data use the Main 
Screen. 

 

 

 

 

 

Figure 2–2. Main Screen Detail 

For additional information on the Main Screen see Section 4.4.1. through 4.4.1.7.  

RUNTIME MODE  
Shows Indicator Panel With 
Track, Switch, Signal and 
Generic Controls Available. 

PLAYBACK MODE  
Displays Recorder Used 
To Playback Log Data. 

WATCH WINDOW 
Activated By Enable Watch 
Window, Displays Data. 

HELP 
Provides Access To Help 
Dialog. 

SETTINGS 
Provides Configuration Of Software 
Options Such as Select A Project, 
Configure Ports, Select Playback 
Source, Enable Automatic Log 
Retrieval, And Others. 

TOOLS  
Provides Access To MMS Runtime Tools: 
- Maintenance Diagnostics 
- Application Explorer 
- Log Manager 
- Configuration Manager 
- Task Scheduler 
- Communication Explorer 

STATUS BAR  
Displays MMS Runtime 
Information As An 
Expandable Text List. 
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2.2.3. Maintenance Diagnostics Screen 

To display hardware status and diagnostic data along with troubleshooting and 
suggested solutions use the Maintenance Diagnostics Screen. 

 

 

 

 

 

Figure 2–3. Maintenance Diagnostics Screen Detail 

For additional information on the Maintenance Diagnostics Screen see Section 4.4.2. 

INFORMATION DISPLAY 
Displays Selected Board And 
Expanded Diagnostic Information. 

Edited By Selecting EDIT > BOARD 
INFORMATION In The Toolbar At 
The Top Of The Screen. 

DIAGNOSTIC DISPLAY 
Displays Selected Board Diagnostics 
For This Session 
Check Display History To View All 
Diagnostics For Selected Board. 

Edited By Selecting EDIT > LOG 
COMMENT In The Toolbar At The 
Top Of The Screen. 

STATUS BAR  
Displays MMS Runtime 
Information As An 
Expandable Text List. 

HOME 
Return To The 
Main Screen. 

CLEAR SYSTEM DIAGNOSTICS 
Sends A Clear Diagnostics Message 
To The Associated Control System. 

GRAPHICAL MODULE DISPLAY 
Shows Module Layout, Used To Select Board: 
yellow = warning 
red = error 

EDIT 
Used To Edit Board Information Or Log 
Comments.  
EDIT > BOARD INFORMATION or  
EDIT > LOG COMMENT 

HELP 
Provides Access To Help 
Dialog. 
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2.2.4. Application Explorer Screen 

To display VPI application variable data for tracing possible problems use the 
Application Explorer Screen. 

 

 

 

 

 

Figure 2–4. Application Explorer Screen Detail 

For additional information on the Application Explorer Screen see Section 4.4.3. 

STATUS BAR  
Displays MMS Runtime 
Information As An 
Expandable Text List. 

VARIABLES TOOL BAR 
Used To Watch, Age, Remove, 
And Upgrade Variables. 

ALARM TOOL BAR 
Used To Set Or Cancel Posted 
Alarms. 

WATCH WINDOW 
Displays Selected Variables 
Whose Values Are Being 
Monitored. 

FILTERS LIST  
Used To Select Data Type 
From The Variable Types 
Available In The Current 
Application. 

RECORD / PLAYBACK 
CONTROLS 
Used To Record Values As 
They Are Received And To 
Save Them To A Watch Log. 

VARIABLES LIST  
Displays Variables Available 
For Adding To The Watch 
Window. 

LOGIC WINDOW / HISTORY 
WINDOW 
Shows Data Type Selected On 
The Display Tool Bar . 

SETTINGS 
Allows Configuration Of This 
Screen Options: True/False 
Colors, Logic Display Type, Alarm 
Tab Sounds, Playback Source. 

HOME 
Return To The 
Main Screen. 

MODE TOOL BAR 
Indicates Whether Run Time 
(Real Time) or Playback 
(Recorded) Data Is Displayed. 

DISPLAY TOOL BAR 
Indicates Whether Logic 
Window Or Timing Window Is 
Displayed. 

APPLICATION TOOL BAR 
Shows The Applications In The 
Control System, Select Desired 
Application Here. 

HELP 
Provides Access To Help 
Dialog. 
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2.2.5. Log Manager Screen 

To retrieve VPI CSEX Data Logs use the Log Manager Screen.  

 

  

 

 

 

Figure 2–5. Log Manager Screen Detail 

For additional information on the Log Manager Screen see Section 4.4.4. 

APPLICATION TOOL BAR 
Displays The Active System's 
Applications That Have 
Associated Data Log Ports. 

PLAYBACK SOURCE 
Allows Selection Of Playback 
Source. HOME 

Return To The 
Main Screen. 

HELP 
Provides Access To Help 
Dialog. 

RETRIEVE 
Used To Select Data Log, Date/Time, 
and Logger Version Information. 

ARCHIVE 
Allows Archiving Of Project 
Logs. 

REPORTS 
Creates reports from retrieved 
data logs or MMS event logs. 
REPORTS > DATA LOG 
REPORTS > EVENT LOG 

STATUS BAR  
Displays MMS Runtime 
Information As An 
Expandable Text List. 

REPORT DISPLAY AREA 
Displays Text Describing The 
Retrieval Process Status. 
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2.2.6. Configuration Manager Screen 

To display VPI control system hardware and firmware configuration information use the 
Configuration Manager Screen.  

 

 

 

 

 

Figure 2–6. Configuration Manager Screen Detail 

For additional information on the Configuration Manager Screen see Section 4.4.5. 

SAVE REPORT 
Save Data. 

REPORT DISPLAY WINDOW 
Displays Configuration Reports. 

STATUS BAR  
Displays MMS Runtime 
Information As An 
Expandable Text List. 

HOME 
Return To The 
Main Screen. 

HELP 
Provides Access To Help 
Dialog. 

VALIDATE  
For Applications Reports Expected And Actual Firmware Configuration For 
Each Application Of The Selected System. 
For Hardware Reports Expected Hardware Configuration For Each 
Application Of The Selected System. 
VALIDATE > FIRMWARE 
VALIDATE > HARDWARE

PRINT  
Prints Report To The 
Default Printer.

This Area Shows 
Validation Progress. 
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2.2.7. Task Scheduler Screen 

To display and schedule maintenance tasks use the Task Scheduler Screen.  

 

 

 

 

 

 

Figure 2–7. Task Scheduler Screen Detail 

For additional information on the Task Scheduler Screen see Section 4.4.6. 

CALENDAR WINDOW  
Displays The Calendar 
With Incomplete Task Due 
Dates In Bold, Used To 
Select Date Range. 

TOOL BAR  
Provides 5 Icons: 
NEW Is Used To Create A New Task Entry. 
EDIT Is Used To Modify An Incomplete Selected Task. 
COPY Is Used To Create A Copy Of The Select Task. 
COMPLETE Is Used To Mark The Task As Complete. 
REMOVE Is Used To Remove The Selected Task. Use This Icon 
With Care; There Is No Undo. 
PRINT is not implemented on this screen. 

TASK DISPLAY WINDOW 
Displays The Tasks For 
The Selected Date Range.

STATUS BAR  
Displays MMS Runtime 
Information As An 
Expandable Text List. 

HOME 
Return To The 
Main Screen. 

PRINT  
Prints Screen To The 
Default Printer. 

HELP 
Provides Access To Help 
Dialog. 
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2.2.8. Communication Explorer Screen 

Use the Communication Explorer Screen to display a VT100 terminal emulator for users 
who prefer command line formats with capture and macro support. 

 

 

 

 

 

Figure 2–8. Communication Explorer Screen Detail 

For additional information on the Communication Explorer Screen see Section 4.4.7 

VT100 DISPLAY WINDOW  
Blanked On Selection Of An 
Application, Then Displays 
Keyboarded Data. 
If Another Icon Is Clicked On The 
Screen, Always Click On The 
Vt100 Display Window Before 
Resuming Keyboard Entry. 

MACRO FILE TOOL BAR  
Used To Record A Sequence 
Of Keystrokes That Can Be 
Played Back In The VT100 
Window. 

CAPTURE TOOL BAR  
Used To Record VT100 
Characters As They Are 
Received From The Equipment 
For Display. 

STATUS BAR  
Displays The Current 
Status Of The Macros And 
Capture Functions. 

APPLICATIONS TOOL BAR  
Displays The Active System's 
Available Applications. 

HOME 
Return To The 
Main Screen. 

HELP 
Provides Access To Help 
Dialog. 
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3. SECTION 3 – MMS EDITOR 

3.1. GENERAL 

This section describes the use of the Maintenance Management System (MMS) Editor 
software program. 

3.2. MAINTENANCE MANAGEMENT SYSTEM PROJECT CREATION 

The MMS Editor, shown in Figure 3–1, imports CAAPE project data from an MMS file 
(CAAPE 6A or later) or the files listed and described in Table 3–1. Use of the MMS file 
is desirable as it contains additional information not gathered through the .cpb files. 
Table 3–2 summarizes the steps to create an MMS project in MMS Editor, while, 
including references to additional tables detailing the steps. 

 

Figure 3–1. MMS Editor 

MENU 

TOOLBAR 

ATTRIBUTES / PARAMETERS 

SYMBOL TOOLBAR 

LAYOUT 
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Table 3–1. CAAPE Project Data Imported by the MMS Editor When .CPB is Used 

File Extension Description 

.%BV CAAPE build file for configuration information. 
.caq VPI CSEX data log variables and sources 
.cfn 
.cfg 

Configuration files created and saved in the Reports folder when a 
compile is done in CAAPE. These files have a .cfg extension for 
Vital applications and a .cfn extension for non-vital applications. 

.cpb CAAPE project file used to gather top level information and all 
other files 

.csi VPI CSEX data log ports and features 
.css Communications file to gather port information and VPI variables 

that can be linked to the graphical symbols 
.lvc 
.lcs 

Vital and non-vital variable information; files are copied as part of 
the MMS project data 

.hdw Module board layout description 
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Table 3–2. MMS Editor Project Creation Process 

Step Action 

1 Using CAAPE (Computer-Aided Application Programming Environment) 
create the VPI System application(s).  
CAAPE project files are necessary for building an operational MMS project. 
See Section 3.3. Setting Up VPI Ports to Acquire Data. 

2 Run MMS Editor. 
From the Start menu choose Programs->Alstom Maintenance Management 
System->Editor. 

3 Create a New Project. 
From the Editor menu choose Files->New Project. See Table 3–3, Creating 
a New MMS Project. 

4 Create the plant layout (optional). 
Using the symbol toolbar choose symbols to represent field devices and 
graphically build the plant layout. See Table 3–4, Building the Location 
Model.  
Modify the symbol attributes as necessary. See Section 5, Symbols, for 
symbol detail. 

5 Import CAAPE project information. 
From the Editor menu choose Files->Import from CAAPE. See Table 3–5, 
Importing CAAPE data. 

6 Link VPI variables to the symbols. 
Once CAAPE data has been imported: Select a symbol. Select the 
Parameters tab. Drag-and-drop variables from the variables dialog to the 
variable column of the Parameters grid. See Table 3–6, Linking VPI 
Variables to Symbol Parameters. 

7 Add MMS port information (optional), hardware information (optional), and 
save the project. 
From the MMS Editor menu choose Edit -> Additional MMS Data. See 
Table 3–7, Adding MMS Specific Data. 
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3.3. SETTING UP VPI PORTS TO ACQUIRE DATA 

3.3.1. CPU/PD Diagnostic Port 

From the CPU/PD diagnostic port, the MMS uses Control System Status, Diagnostics, 
Vital Application variables (Application Explorer / Project Watch window), Configuration 
Reports and VT100 emulation when Vital Diagnostic Protocol (VDP) is not used. 

For this port, the serial port configuration is 1200 baud, 8 data bits, 1 stop bit, no parity. 
No application programming is required. 

3.3.2. CSEX Diagnostic Port 

From the CSEX diagnostic port, the MMS uses Non-Vital Application variables 
(Application Explorer / Project Watch window), Non-Vital Configuration Reports, Clock 
synchronization (if password not used) and VT100 data. 

For this port, enter the desired diagnostic port setup data for each application, including 
baud rate and data format.  

Default values are 9600 baud, 8 data bits, 1 stop bit and no parity unless otherwise 
specified. 

See CAAPE online help for specifics on the input records. 

Text Records (CSI File) 

• DIAGNOSTIC TERMINAL TYPE = MAC 

• DIAGNOSTIC TERMINAL BAUD RATE = baud-rate 
where baud-rate is the terminal baud rate 

• DIAGNOSTIC TERMINAL DATA FORMAT = data-bits, stop-bits, parity 
where data-bits is the number of data bits, stop-bits is the number of stop bits, and 
parity is E for even, O for odd or N for none 

Graphics 

• Use the Terminal section of the Diagnostics tab on the CSEX board's editing dialog 
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3.3.3. CSEX Diagnostic port with Vital Diagnostic Protocol (VDP) 

From CSEX diagnostic port with VDP, the MMS uses Non-Vital Application variables 
(Application Explorer / Project Watch window), Non-Vital Configuration Reports, Clock 
synchronization, Control System Status, Diagnostics, Vital Application variables 
(Application Explorer / Project Watch window), Vital Configuration Reports and VT100.  

To configure the port for VDP to be used to route CPU/PD diagnostics through a CSEX 
board, enter the appropriate records for the CPU/PD and CSEX applications. VDP data 
can be passed from CPU/PD to CSEX either through dual-ported RAM or through a 
serial connection between the CPU/PD board's diagnostic port and one of the CSEX 
board's serial ports.  

See CAAPE online help for specifics on the input records.  

Text Records (CPU/PD - VPC File) 

• For DPRAM transfer: VITAL DIAGS = CSEX BOARD board-number where board-
number is the number of the CSEX board, 1 through 4 

• For serial port transfer: no record 

Text Records (CSEX - CSI File) 

• For DPRAM transfer: VITAL DIAGS = DPRAM 

• For serial port transfer: VITAL DIAGS = PORT port-number, csex3-mode, baud-rate 
where port-number is the port number, csex3-mode is an optional CSEX3 
compatibility mode, and baud-rate is the baud rate 

Graphics 

• Use the Vital Diagnostics Interface section of the Diagnostics tab on the CSEX 
board's editing dialog. 
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3.3.4. CSEX Port with DataTrain VIII Protocol 

From the CSEX port with DataTrain VIII protocol, the MMS uses symbol parameter 
controls and indications. 

For this configuration, enter the desired port setup data for each application, including 
baud rate and data format.  

See CAAPE online help for specifics on the input records. 

Text Records (CSEX - CSS File) 

• SERIAL PORT port number = TYPE (DT8 SYNC), LATCHED CONTROLS 

• DEFAULT BAUD RATE = baud rate 

• DATA FORMAT = data bits, stop bits, parity 

• OPERATING MODE = RS-232 

• CONTROL = ADDRESS (binary address), LENGTH (length) 
position = variable name 

• INDICATION = ADDRESS (binary address), LENGTH (length) 
position = variable name 

Graphics 

• Configure the Message components and use the Board and Port tabs on the CSEX 
board's editing dialog. 
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3.3.5. CSEX Port for Data Log 

From the CSEX port for data log, the MMS uses CSEX Data Log retrieval. 

To configure this port to retrieve CSEX Data Logs, enter the appropriate records for the 
CSEX applications. 

The Tracker Interface is used to transfer Data Log data. 

See CAAPE online help for specifics on the input records. 

Text Records (CSEX - CSI File) 

• DATA LOGGING = ON 

• TRACKER INTERFACE = PORT port number, INPUT ADDRESS (binary address), 
OUTPUT ADDRESS (binary address) 

Text Records (CSEX - CSS File) 

• SERIAL PORT port number = TYPE (DT8 SLAVE) 

• DEFAULT BAUD RATE = baud rate 

• DATA FORMAT = data bits, stop bits, parity 

• *DUMMY CONTROL MESSAGE 

• CONTROL = ADDRESS (binary address), LENGTH (8) 
 
1 = PERMZERO 
 
2 = PERMZERO 
 
3 = PERMZERO 
 
4 = PERMZERO 
 
5 = PERMZERO 
 
6 = PERMZERO 
 
7 = PERMZERO 
 
8 = PERMZERO 
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• *DUMMY INDICATION MESSAGE 

• INDICATION = ADDRESS (binary address), LENGTH (8) 
 
1 = PERMZERO 
 
2 = PERMZERO 
 
3 = PERMZERO 
 
4 = PERMZERO 
 
5 = PERMZERO 
 
6 = PERMZERO 
 
7 = PERMZERO 
 
8 = PERMZERO 

• TEXT CONTROL = ADDRESS (binary address), LENGTH (length), NAME (name) 

• TEXT INDICATION = ADDRESS (binary address), LENGTH (length), NAME (name) 
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Text Records (CSEX - LOG File) 

• DATA LOGGING SECTION 

• LOCATION ID = location id 

• DATA PROTECT = hours HOURS, minutes MINUTES 

• AUTO DUMP = OFF 

• DATA LOG = PORT port (port event list) 

• DATA LOG = (general event list) 

• INPUT LOG = [PERIOD (minutes MINUTES, seconds SECONDS)], [SAMPLES 
(samples)], [CHANGE DETECT] [FLAGGED] 

• OUTPUT LOG = [PERIOD (minutes MINUTES, seconds SECONDS)], [SAMPLES 
(samples)], [CHANGE DETECT] [FLAGGED] 

• MSG LOG = [PERIOD (minutes MINUTES, seconds SECONDS)], [SAMPLES 
(samples)], [CHANGE DETECT] [FLAGGED] 

• PRINT MODE = [FIFO], [LIFO] 

• DATA LOGGING INTERFACE = TRACKER 

• APPLICATION LOG MESSAGE = ADDRESS(binary address),LENGTH(length) 
position = variable name 

Graphics 

• Configure the Message components and use the Data Log tab on the CSEX board's 
editing dialog. 
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3.3.6. Vital Board Network Ports 

For MMS to use the Vital diagnostic network port, the Vital board must be configured to 
use networking, have a network port enabled, have diagnostics enabled on that network 
port, and have an IP address assigned to that network port. 

See the appropriate CAAPE reference manual or online help for specifics on input 
records. 

3.3.7. Non-Vital Board Network Ports 

For MMS to use the non-vital diagnostic network port, the non-vital board must be 
configured to use networking, have a network port enabled, have diagnostics enabled 
on the network port, and have an IP address assigned to that network. If a Panel is 
used, then a Panel message must be configured. If data logs are to be archived, then 
the network port must be specified. 

See the appropriate CAAPE reference manual or online help for specifics on input 
records. 

3.3.8. Compiler Report Options 

Before compiling each application, make sure that the Listing Reports section of the 
application's Run Controls includes at least these options (any other listing options may 
be selected as well): 

• Generate Tracker Information 

• Parameters 

• Logic Equations 

This data must be available in the report file for MMS Runtime to display readable 
variable names and logic statements and playback CSEX Data Logs 
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3.4. MMS EDITOR OPERATION 

The MMS Editor screen, as shown in Figure 3–1, includes a standard pull down menu 
and tool bar used to perform basic windows functions such as open files, save files, and 
cut and paste content. The MMS Editor specific part of the screen includes displayed 
graphical layout, a symbol tool bar, and an attributes/parameters data input table.  

3.4.1. Modifying User MMS Software Preferences  

To modify MMS Editor user preferences, select from the menu Tools->Options. A 
window is displayed with two tabs: a General tab and a Colors tab. 

The General tab includes the following preferences: 

• Directories: Default folders for project files 

• Traffic:  Text for direction (not used) 

• Grid:  Size in pixels of grid spacing (5 to 25); symbols are snapped to the nearest 
grid 

• Cab Rate:  Table of cab signal rates (not used) 

• Show All Warnings:  Enable all warning dialogs to be shown 

• Show Variable Dialog on Parameters Tab:  Displays variables dialog to allow 
variable linking 

The Colors tab accesses 5 additional tabs: 

• General tab 

− Background:  Color of drawing area background 

− Default:  Default color of Track, Switch and Grade Crossings 

− Select:  Border color of symbol when selected 

− Route:  Color to indicate part of route 

− Occupied:  Color of Track, Switch and Grade Crossing when occupied 

− Blocked:  Color of Track, Switch and Grade Crossing when blocked 

− Alternate Track:  Default Alternate track color 
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• Switch tab 

− Locked:  Color of locked indication 

• Signal tab 

− Pending:  Color of border when request is pending 

− Failed:  Color of border when request has failed 

• Timer tab 

− Running:  Color of symbol when running 

• Generic tab 

− Indication:  Color of symbol when indication is set 

− Direction:  Default color of Direction Indicator 

− Locked:  Color of Direction Indicator when locked 
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3.4.2. Creating a New MMS Project 

Table 3–3. Creating a New MMS Project 

Step Action 

1 Select from the menu File->New (or use the new project icon on the basic 
tool bar). This initiates the New Project Wizard. This Wizard provides dialog 
that prompts the user to enter project information and choose a project 
template. 

2 An introductory screen is displayed. Select NEXT. 
3 The Information Page is now displayed.  

Enter the project location (the folder must exist) and name in the fields 
provided.  
This screen contains additional fields provided for optional information. 
Once the Information Page is complete, select NEXT. 

4 The Template Page is now displayed.  
A default template is available. The first time the editor is used this is the 
only available template. Use the default template to create a default MMS 
project. 
Once a project is created it can be saved as a template (using File > Save 
As on the menu). Any previous MMS Project saved as a template appears 
in the list of available templates. All project data except linked variables is 
saved in a template. To use a template that was saved with a password, 
enter the password designated at file creation.  
Once a Template is selected, select NEXT. 

5 The Summary Page is now displayed.  
This page shows the entries made on the Information and Template Pages. 
If the listed entries are correct, select FINISH and the project database is 
created with the default information. 
If the listed entries are not correct, select the back icon(s) to back up to the 
desired data page and correct any inaccurate data, then use the next 
icon(s) to come back to the Summary Page. Select FINISH to create the 
project database. 
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3.4.3. Building the Location Model  

The user builds the location model using symbols from the symbol tool bar. See Section 
5 for a summary of the available symbols and their icons. Follow the procedure in Table 
3–4 to build a location. 

Table 3–4. Building the Location Model 

Step Action 

1 Select a symbol from the symbol toolbar. The mouse pointer is displayed 
as thin cross hairs. 

2 Click in the Layout Area to place the symbol (see Section 5 for symbol 
information). Click again to place a second one, and so forth.  

3 Click the right mouse button to return the mouse pointer to the Select 
arrow. 

4 Select a symbol by left-mouse clicking over a symbol in the layout area; the 
border is drawn in the selected color. Multiple symbols can be selected by 
holding the control key down while performing the select operation or by 
highlighting or “rubber banding” a selection area. 

5 Symbols can be moved, cut, copied or deleted. Cut or copied symbols can 
be pasted. All operations may be undone. The undo buffer is limited only by 
available memory. 

 

For a selected symbol, the Properties tab lists the symbol properties and values (such 
as connections to other symbols, display parameters, etc). Attribute property values 
whose Attribute names (left column) are not enclosed in square brackets [ ] can be 
edited. These values are edited by either choosing from a drop-down list of items or 
entering values. Up and Down arrow keys can be used to navigate through the 
properties table. 

NOTE 

Fixed attribute property values cannot be edited. 

The Parameters tab lists the symbol parameters and linked VPI variables.  
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3.4.4. Importing CAAPE Data 

VPI module board layout, communication port, link variable, data logger and 
configuration information is gathered from CAAPE project files. To import the data follow 
the procedure in Table 3–5. 

Table 3–5. Importing CAAPE Data 

Step Action 

1 Select from the menu File >Import from CAAPE. 
All existing imported system applications are listed. 

2 To add new system applications browse to the required CAAPE project file 
(extension .mms or .cpb).  
All system applications found in the project are added to the 
system/applications list. 
Repeat the process to enter all required CAAPE projects. 

3 Check USE to include the application data in the import list. 
System and Application names may be modified (these names are used in 
MMS Runtime) in the attributes/parameters table on the screen. 

4 Existing application data can be updated by selecting from the menu  
File -> Synchronize to CAAPE.  

5 Any serial port Panel or Tracker messages are listed in the 
Controls/Indications list. Check USE to include this information in the 
imported data. 

6 The station number may be modified (it must match the VPI station number 
for this port for communications to operate properly) in the 
attributes/parameters table on the screen. 

7 FINISH imports the requested VPI System data. 
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3.4.5. Linking VPI Variables To Symbol Parameters 

To link a VPI variable to a selected symbol’s parameter follow the procedure in  
Table 3–6.  

Table 3–6. Linking VPI Variables to Symbol Parameters 

Step Action 

1 Select the Parameters tab in the attributes/parameters table. 
2 Make certain that the box next to Show variable dialog on Parameters tab 

option is checked in Tools -> Options and that CAAPE data has been 
imported (see Table 3–5, Importing CAAPE Data).  

3 Use the mouse to “drag and drop” the symbol for the required variable to 
the Variable field of the Parameter.  
Control type variables can only be linked to control type parameters. 
Control variables are data received by the VPI (MMS → VPI). 
Indication variables can only be linked to indication parameters. Indication 
variables are data sent by the VPI (VPI → MMS). 
Only one indication variable can be linked to a parameter; multiple control 
variables can be linked to a parameter. 

4 To remove the link(s), select the Variable field and press the Delete key on 
the keyboard. There is no undo command for links.  
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3.4.6. Adding MMS Specific Data 

The build wizard is used to add MMS Runtime communication port and additional 
hardware information to the MMS project database. Using this function of MMS Editor is 
not required since the communication port information can be added later in MMS 
Runtime and the additional hardware information is optional. MMS Editor and MMS 
Runtime can use the same database. 

Table 3–7. Adding MMS Data to the Build File 

Step Action 

1 Select from the menu Edit -> Additional MMS Data. 
2 To configure the MMS Runtime communication ports see Section 4, 

heading 4.4.1.3 Settings.  
3 Select NEXT. 
4 Optional additional hardware information may be entered here. 
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3.4.7. Creating a Summary Report 

A summary report can be created and results shown from the MMS Editor.  

Table 3–8. Creating a Summary Report 

Step Action 

1 Select from the menu Tools -> Summary Report. 
2 Use the New Report button on the Summary toolbar to create the report. 
 Save and print the report by using the Save and Print buttons. 

 

3.4.8. Printing a Layout Drawing 

The layout drawing can be printed from the MMS Editor.  

Table 3–9. Printing a Layout Drawing 

Step Action 

1 Select from the menu File > Print or select the Print icon on the standard 
toolbar. 

NOTE 

The layout can only be printed on a single sheet, 
automatically sized to fit. 
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4. SECTION 4 – MMS RUNTIME 

4.1. GENERAL 

This section describes the use of the Maintenance Management System (MMS) 
Runtime software program. 

4.2. MAINTENANCE MANAGEMENT SYSTEM RUNTIME PROCESS 

To launch the MMS software and access the desired system data follow the steps in 
Table 4–1. Detailed explanations of the various screens in MMS Runtime follow. 

Table 4–1. MMS Runtime Process 

Step Action 

1 If the VPI System(s) is not already connected to the PC or laptop 
containing MMS software: make the connections between the VPI 
System(s) and the PC. (See Connect to a VPI System, Section 4.3.) 

2 If MMS Runtime is not already running: from the Start menu choose 
Programs->Alstom Maintenance Management System->Runtime. 
See Section 4.4.1. Main Screen for a description of what is displayed when 
the software launches and how to choose a project. 

3 Display the desired data: 
To display system control system status, control data, and indication data 
use the Main Screen, see Section 4.4.1 through 4.4.1.7. 
To display hardware status and diagnostic data along with troubleshooting 
and suggested solutions use the Maintenance Diagnostics Screen, see 
Section 4.4.2. 
To display VPI application variable data for tracing possible problems use 
the Application Explorer screen, see Section 4.4.3. 
To retrieve VPI CSEX Data Logs use the Log Manager Screen, see 
Section 4.4.4. 
To display VPI control system hardware and firmware configuration 
information use the Configuration Manager Screen, see Section 4.4.5. 
To display and schedule maintenance tasks use the Task Scheduler 
Screen, see Section 4.4.6. 
To display communication information, including a VT100 terminal emulator 
for serial connections and network statistics for network connection, see 
Section 4.4.7. 
Capture and macro support are included in VT100 Screen use. 
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4.3. CONNECT TO A VPI SYSTEM 

Up to 16 serial communications ports can be connected on the MMS Runtime 
computer. Each port must be configured to the appropriate type and settings (baud, 
parity, etc).  

Table 4–2 provides a list of port types and their applicable connections. Examples of 
various port connections are provided in Figures 4–1 to 4–6.  

Table 4–2. VPI Connection Ports 

Port Type Connection 

CPU/PD MAC CPU/PD diagnostic port w/ system firmware earlier than  
40025-329 (VPI CAA 31746-029). User is not able to view vital 
variables in Application Explorer; Project Watch window can view 
one vital variable at a time. 
CPU/PD diagnostic port w/ system firmware 40025-329 (VPI 
CAA 31746-029) to 40025-404 (VPI CAA 31746-033A). User can 
view up to 16 vital variables in Application Explorer. 
CPU/PD diagnostic port w/ system firmware 40025-404 (VPI 
CAA 31746-033A) or later. User can view up to 64 vital variables 
in Application Explorer. 

CSEX MAC CSEX MAC port; no Vital Diagnostic Protocol (VDP) with this 
configuration. 

CSEX-VDP MAC CSEX MAC port w/ Vital Diagnostic Protocol (VDP); all vital 
communications compatible w/ CPU/PD MAC (40025-329, VPI 
CAA 31746-029 or later) port type routed through this port. 

CPU II  Preferred: CPU II network connections via Two 10/100-baseT 
Ethernet network controllers. 
CPU2 Main Processor diagnostic port. 

VSP Preferred: VSP (iVPI) network connections via Two  
10/100-baseT Ethernet network controllers. 
VSP Main Processor diagnostic port. 

NVSP Preferred: NVSP (iVPI) connections via Two 10/100-baseT 
Ethernet network controllers. 
NVSP Main Processor diagnostic port (serial port 4) is used for 
connecting the NVSP Main Processor to a PC, supports 
asynchronous EIA-232, and is available at the front DB-9 
connector or USB port or through P3 on the backplane (switch 
selectable). 

DATATRAIN VIII CSEX serial port w/ DataTrain VIII protocol. 
DATALOG CSEX serial port w/ Tracker interface; the Tracker Interface 

protocol is used by MMS Runtime to retrieve Data Logger data. 
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Figure 4–1. CPU/PD 191B and CSEX3 Connections In a System with 1 CSEX3 Board 
and a USB Port 
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Figure 4–2. CPU/PD 191B and CSEX3 Connections In a System with 1 CSEX3 Board 
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Figure 4–3. CPU/PD 191B and CSEX3 Connections In a System with 2 CSEX3 Boards 
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Figure 4–4. CPU II Ports 
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Figure 4–5. CPU II and CSEX4 Diagnostics 
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Figure 4–6. VSP and NVSP Remote Diagnostics 
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4.3.1. Other Recommended Connection Configurations 

Since many PCs do not have multiple or any serial COM ports, USB ports may be used 
with appropriate adapters to provide these ports. 

Alstom Product Development has successfully implemented the alternate connections 
listed in Table 4–3. 

Table 4–3. Alternate VPI Connections 

Connection Equipment 

USB to RS-232 port 
(DB9) 

RadioShack 6 ft USB to Serial Cable (26-183) 
ATEN USB-Serial converter (UC-232A) 

USB to 4 RS-232 
ports (DB9) 

Keyspan USB 4-Port Serial Adapter (P/N USA-49WLC) 

USB 4 port hub RadioShack Illuminations USB 2.0 Hub (26-137) 
 
Note: USB 4 port hub used with USB to RS-232 port (DB9) adapters to 
provide 4 RS-232 ports. 

RS422 to RS232 B & B RS232/422 converters (422 PP 9TB) 
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4.4. MMS RUNTIME 

The first time that MMS Runtime starts, the user is prompted to locate and select a 
project database file. The selected file is copied to the MMS Apps folder.  

The user can choose to select a project on startup or always startup with a specific 
project. Archived projects can also be opened for playback. A project can be added to 
the project list through the Upload button. 

NOTE 

If a user has chosen to always open a specific project, a new project can 
be selected or “Choose Project On Startup” can be selected through the 
MMS Runtime Settings dialog. 

Once MMS Runtime is started, the project layout display is shown and initialization is 
performed. If MMS Runtime has been configured to connect to VPI via DataTrain VIII 
communications ports, the status of those ports is displayed on the Status Bar (typically 
"Port x Station y is on-line"). 

The Control Systems icons indicate the VPI system status: 

• green frame – normal 

• yellow frame – warning 

• red frame – error 

• blue frame with "?" – unknown 

An unknown Control System status on startup is most likely due to an MMS Runtime 
port to VPI MAC port communication problem. 

While MMS Runtime is operational (in a session) all Control System status, diagnostics 
and linked indications are logged. A new session log is created each time MMS Runtime 
is started. 
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4.4.1. Main Screen 

 

Figure 4–7. MMS Runtime, Main Screen 

The Main screen is used for graphical display of control system status, control data, and 
indication data. It provides access to other MMS Runtime screens. 

The top of the screen includes icons that provide access to the MMS Runtime modes, 
the Project Watch Window, Settings, and Help. 
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4.4.1.1. Main Screen Modes 

There are two Main Screen Modes accessible by icons on the top left side of the 
screen: 

1. Runtime Mode is the normal operation mode. 

2. Playback Mode, which displays the recorder. Track Layout indications display 
playback log data. Runtime data may still be recorded. Played back logs include 
MMS Event Logs or VPI Data Logs (user selectable). 
 
The played back controls are as follows: 
 
|<    BOB (beginning of buffer): Go to the beginning of the session or log 
 
>|    EOB (end of buffer): Go to the end of the session or log 
 
<    Reverse: Play data in reverse (newest to oldest) 
 
>    Forward: Play data in forward (oldest to newest) 
 
||    Pause: Pause record/playback; pressing key again resumes last operation 
 
||||    Stop: Stop record/playback 
 
Available playback speeds include single-step, 1/10x, 1/2x, 1x, 2x and 10x. 
 
The slider bar can position playback to start anywhere in the buffer. 

4.4.1.2. Project Watch Window  

The Project Watch Window feature displays all variables present in Application Explorer 
Watch windows. Due to the VPI communications processing, System Status information 
is not gathered while the Project Watch window is active (serial port communication). 

Individual Vital variable data can be queried through the expanded Project Watch 
Window. Vital variables can be dragged from the Project Watch Window to the Addr 
field or specific addresses can be entered. The variable name, codeword and true/false 
indication are displayed. 

To activate this feature select the Project Watch Window button at the top of the screen. 

To deactivate this feature select the Project Watch Window button (toggle) at the top of 
the screen 

4.4.1.3. Settings 

The Settings icon is located at the top of the screen. Once this icon is selected, a 
window with the following tabs appears: 
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• The Access Level tab is not implemented at this time.  

• The Clock Sync tab is used to synchronize all VPI System clocks to the MMS clock 
(VPI password cannot be used for this feature to work). 

• The Projects tab is used to choose a project on startup or select a project to load at 
MMS Runtime startup. 

• The Ports tab is used to configure the MMS serial communication ports. The initial 
screen shows the active ports with buttons to Add, Remove, and Show Properties. 

− Add is used to add network and serial ports 

− Remove is used to remove selected active ports 

− Properties is used to modify a selected active port properties 

• The Colors tab is used to configure user settable colors. 

• The Watch tab is used to identify full names (format - system::application.variable) in 
Project Watch Window. (Short name is just the variable name). Since variables from 
multiple applications can be displayed, the use of short names may cause 
unexpected results if two or more applications have the same variable name; data 
for that variable name is updated for each application. 

• The Diagnostic tab is used to display detailed diagnostic data. 

• The Record tab is a feature not implemented on this screen. 

• The Playback tab is used to select the playback source (MMS Event log / VPI Data 
log) and to choose beginning / end playback times. 

• The Log Retrieval tab is used to enable automatic data log retrieval. Time and length 
of next retrieval can be configured here. 

• The Printer tab is used to select the default printer. 
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4.4.1.4. Help 

The HELP icon, located at the top of the screen, accesses the software help 
information, organized as follows: 

• Contents and Index, displays the Help dialog 

• How do I?, displays the Help 'How do I?' section 

• About, displays the 'About' dialog 

4.4.1.5. Control Systems 

The Control Systems icon is located in the lower left corner of the screen. System status 
is indicated the icon as follows: 

• green frame – normal 

• yellow frame – warning 

• red frame – error 

• blue frame with "?" – unknown 

An unknown Control Systems status on startup is most likely due to an MMS Runtime 
port to VPI MAC port communication problem. 

The active system is shown as depressed icon. The active system is used in the 
Maintenance Diagnostic, Application Explorer, Log Manager, Configuration Manager, 
and Communication Explorer screens. 

4.4.1.6. Status Bar 

The status bar displays MMS Runtime information as an expandable text list. The last 
50 items are displayed with their associated time stamps when the up arrow at the right 
of the bar is selected. 
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4.4.1.7. Tools 

The bottom right corner of the screen includes six tools icons used to run the associated 
tools: 

• Maintenance Diagnostics 

• Application Explorer 

• Log Manager 

• Configuration Manager 

• Task Scheduler 

• Communication Explorer 
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4.4.2. Maintenance Diagnostics 

 

Figure 4–8. MMS Runtime, Maintenance Diagnostics Screen 
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The Maintenance Diagnostics tool is used for graphical display of control system 
hardware status and diagnostic data. 

• The Home icon at the top left of the screen returns to Main screen. 

• The Clear System Diagnostics icon sends a clear diagnostics command to the 
associated Control System. 

• The Edit icon is used to edit selected board information or add log comments. 

• The Help icon accesses the user Help information.  

• The Graphical Module Display on the left side of the screen shows the module 
layout. Individual board information and diagnostics is viewed by selecting the 
appropriate board. Board status is indicated as yellow for warning or red for error. 

• The Information Display on the left bottom of the screen displays the selected board 
and expanded Diagnostic information. Navigation is done through embedded links 
and/or the navigation keys. 

• The Board Information Display at top right side of screen displays selected board 
information. 

• The Diagnostic Display in the bottom right portion of the screen displays the selected 
board diagnostics for this session. Check Display History to view all diagnostics for 
this board. Select the diagnostic statement to display expanded information. 

• The Status Bar along the bottom of the screen displays MMS Runtime information 
as an expandable text list. The last 50 items are displayed with their associated time 
stamps when the up arrow on the right side of the bar is selected. Two icons show 
the selected System status (left) and the worst-case status of all Systems (right). 
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4.4.3. Application Explorer 

 

Figure 4–9. MMS Runtime, Application Explorer Screen 
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The Application Explorer tool aids the troubleshooting of VPI systems by accessing 
variable data obtained through the diagnostic ports. Multiple logic, message or I/O 
variables can be viewed in near real time. Variables are displayed using their assigned 
names and their current Boolean or integer values. Application logic statements can be 
displayed including the current values of the variables that comprise them. 

• The Home icon at the top left of the screen returns to Main screen. 

• There are three Tool bars located at the top of this screen: 

− Mode Tool Bar indicates whether Application Explorer is currently displaying real 
time data or playing recorded data. 

− Application Tool Bar shows the applications in the active Control System. Click 
on one of the icons in the tool bar to make an application active. 

− Display Tool Bar indicates whether the Logic Window or Timing Window is 
displayed. 

• The Settings icon at the top of the screen accesses four tabs that allow the user to 
configure this screen: 

− The True / False Colors tab controls the color of True or False Boolean variables 
displayed in the Watch Window and the Logic Window. 

− The Logic Display Type tab controls the display format of logic statements in the 
Logic Window. Text format and three graphical formats (ladder, straight line, drop 
line) are available. 

− The Alarms tab controls the .wav files (sound) that are played when an alarm is 
sounded. 

− The Playback tab selects the playback source [MMS Event log (Watch log)/ VPI 
Data log] and beginning / end playback times. 

• The Help icon at the top of the screen accesses the user Help information.  
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• Record / Playback controls are located below the Mode tool bar. The controls are 
used to record variable values as they are received and save them to a Watch Log 
File. Playback can use Watch Log files or VPI Data Logs. All playback data is 
displayed as a timing diagram. 
 
|<    BOB (beginning of buffer):  Go to the beginning of the session or log 
 
>|    EOB (end of buffer):  Go to the end of the session or log 
 
<    Reverse:  Play data in reverse (newest to oldest) 
 
>    Forward:  Play data in forward (oldest to newest) 
 
||    Pause:  Pause record/playback; pressing key again resumes last operation 
 
||||    Stop:  Stop record/playback 
 
Available Playback speeds include single-step, 1/10x, 1/2x, 1x, 2x and 10x  
 
The slider bar can position playback to start anywhere in the buffer. 

• The Load icon is used to load a previously saved Watch log file for playback. 

• The Save icon is used to save Application Explorer recorded data in a Watch log file. 

• The Clear icon is used to clear the buffer. 

• The Record icon is used to record Application Explorer data. 

NOTE 

One Application’s selected variable data can be recorded at a time. 
Recorded data is lost when switching to a new application. 
 
If the Applications recorded data needs to be saved, then save it to a 
Watch Log file before switching to a new application. 

• The Variables List icon is located below Record / Playback icons. Variable List 
displays variables available for adding to the Watch Window. Variables are filtered 
by type. 
 
Select one or more variables and add them to the Watch Window. Status updates 
are requested on the added variables. Their display in the Watch Window is updated 
as new status information is received. 
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• The Filters List is located below the Variables List. The Filters List displays the types 
of variables in the current application. The variable types that are checked in the 
Filters List determine the contents of the Variables List. The Filters List contains 
icons to Add (Watch), Remove, Age, or Upgrade the variables list. 

• The Logic Window is located in the middle right portion of the screen. When the 
Equation icon on the Display tool bar is activated, this window displays selected logic 
statements in text or graphical format. To view a logic statement that uses a 
particular variable, double click on the variable in the Watch Window.  
 
If a logic statement using that variable is found, the statement is displayed in the 
Logic Window and a request for status updates on its variables is issued. The 
display of the variables in the statement is updated in the Logic Window as new 
status information is received.  
 
Browse the logic statements and view their status in the Logic Window. See 
Limitations (below) for information on how much variable and logic statement data 
can be viewed at a time. 

• The History (Timing) Window is in the same position as the Logic Window. When the 
Timing icon on the Display tool bar is activated, this window displays a timing 
diagram of recorded data during playback. 

• The Watch Window is the bottom right portion of the screen. It displays selected 
variables whose values are being monitored. 

• The Status Bar along the bottom of the screen displays MMS Runtime information 
as an expandable text list. The last 50 items are displayed with their associated time 
stamps. Two icons show the selected System status (left) and the worst-case status 
of all Systems (right). 

• The Variables Tool Bar is used to watch, age, remove, and upgrade variables. 
Limitations for these variables include: 

− Watch Variables for CSEX Applications using serial connections have a 
maximum of 64 Boolean and 4 integer watch variables, including variables visible 
in the Watch Window as well as temporary logic statement variables. 

− Watch Variables for CSEX/NVSP Applications using network connections have a 
maximum of 128 watch variables, including variables visible in the Watch 
Window as well as temporary logic statement variables. Variables can be a mix 
of either Boolean or Integer. 

• MMS Runtime is unable to monitor subroutine arguments that are passed by 
address rather than by value. 

• MMS Runtime is unable to monitor array variables with a calculated index. 
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− Watch Variables for CPU/PD, CPU II, VSP using serial connections have 
maximums defined in Table 4-2 which include variables visible in the Watch 
Window as well as temporary logic statement variables. 

− Watch Variables for CPU II/VSP using network connections have a maximum of 
128 Boolean watch variables, including variables visible in the Watch Window as 
well as temporary logic statement variables. 

• MMS Runtime is unable to handle vital output state variables because they do 
not have normal true or false values. 

• The Alarms tool bar has icons used to Set or Cancel posted alarms. 
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4.4.4. Log Manager 

 

Figure 4–10. MMS Runtime, Log Manager Screen 
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The Log Manager screen is used to handle the retrieval of VPI Data logs, archiving, 
selecting a playback source, and creating log reports. 

• The Home icon at the top left of the screen returns to Main screen. 

• The Application Tool Bar displays the active System's Applications that have 
associated Data Log ports. Select an Application to retrieve its logs. 

• The Project space used is a gauge indicating the amount of total space used by the 
current MMS log file. The maximum limit is 1 gigabyte or the amount of hard drive 
space available whichever is less. 

− The Action toolbar contains: 

• The Retrieve icon that starts the retrieval of the selected Application's data 
log. All log data is saved in the MMS project data base file (located in the 
Apps folder). Previously retrieved data is skipped; only new data is retrieved. 
The selected Application's log date, time and version can also be retrieved. 

• The Archive icon that archives (copies) the project data base file into the 
Archive folder. The project log data can optionally be cleared once the archive 
is complete. 

• The Playback Source icon selects the source of playback data. Multiple 
archives can be merged for playback. 

• The Reports icon requests creation of data log and MMS event log reports. 
Reports can be saved in text, rich text and comma separated value formats. 

• Playback Tool Bar located near the top center of the screen is not implemented on 
this screen. 

• The Help icon at the top of the screen accesses the user Help information.  

• The Report Display Area in the middle of the screen displays text describing the 
retrieval process status. 

• The Status Bar at the bottom of the screen displays MMS Runtime information as an 
expandable text list. The last 50 items are displayed with their associated time 
stamps when the up arrow on the right side of the bar is selected. Two icons show 
the selected System status (left) and the worst-case status of all Systems (right). 
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4.4.5. Configuration Manager 

 

Figure 4–11. MMS Runtime, Configuration Manager Screen 
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The Configuration Manager tool provides reports of the expected and actual 
configuration items for each Application of the selected System. Both hardware and 
firmware items can be reported. 

• The Home icon at the top left of the screen returns to Main screen. 

• The Validate icon reports expected data: 

− For Applications, this icon reports the expected and actual firmware configuration 
items for each Application of the selected System. 

− For Hardware, this icon reports the expected and actual (if supported) hardware 
configuration items for each Application of the selected System. 

• The Save icon saves the report in rich text format.  

• The Print icon prints to the default printer. 

• The Help icon at the top of the screen accesses the user Help information. 

• The Report display window in the middle of the screen displays the configuration 
reports. 

• The Status Bar at the bottom of the screen displays MMS Runtime information as an 
expandable text list. The last 50 items are displayed with their associated time 
stamps when the up arrow on the right side if the bar is selected. Two icons show 
the selected System status (left) and the worst-case status of all Systems (right). 
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4.4.6. Task Scheduler 

 

Figure 4–12. MMS Runtime, Task Scheduler Screen 
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The Tack Scheduler screen is a basic calendar to do list allowing a user to control 
maintenance tasks. 

• The Home icon at the top left of the screen returns to Main screen. 

• The Calendar window displays incomplete task due dates in bold. Selecting a date 
or range of dates (left mouse key down, drag to end date and release left mouse 
key) displays all the tasks with due dates falling within the date range. 

• The Tool Bar provides six icons: 

− The New icon is used to create a new task entry. 

− The Edit icon is used to modify an incomplete selected task. 

− The Copy icon is used to create a copy of the selected task. 

− The Complete icon is used to mark the task as complete. The completion 
date/time can be entered. 

− The Remove icon is used to remove the selected task. Use this icon with care; 
there is no undo. 

− The Print icon prints a task list report to the default printer. 

• The Help icon at the top of the screen accesses the user Help information. 

• The Task Display Window on the left side of the screen displays the tasks for the 
selected date range. 

• The Status Bar at the bottom of the screen displays MMS Runtime information as an 
expandable text list. The last 50 items are displayed with their associated time 
stamps when the up arrow on the right side of the bar is selected. Two icons show 
the selected System status (left) and the worst-case status of all Systems (right). 



MMS Runtime 

P2509, Rev. Jan/09 4–26 Alstom Signaling Inc. 

4.4.7. Communication Explorer – VT 100 Screen 

 

Figure 4–13. MMS Runtime, Communication Explorer – VT100 Screen 
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The Communication Explorer - VT100 screen provides a VT100 terminal emulation with 
macro and capture capabilities. 

• The Home icon at the top left of the screen returns to Main screen. 

• The Applications Tool Bar at the top of the screen displays the active System's 
available Applications. 

• The VT100 Display Window in the center of the screen is blanked on selection of an 
Application.  
 
Click on the VT100 Display Window and then start keying in whatever is appropriate 
to communicate with the selected application.  
 
If another icon is clicked on the screen, always click on the VT100 Display Window 
before resuming keyboard entry. This moves input focus to the VT100 display 
window so that it can capture keystrokes. 

• The Macro File Tool Bar is used to record a sequence of keystrokes that can be 
played back in the VT100 window. On playback, the saved keystrokes are sent to 
the equipment as if they had been typed. 

− The Rec icon in the Macro Files tool bar is used to start recording a macro file. 
Start keying in characters. As the VT100 window processes the data it also 
records the data in the macro file buffer. 
 
Once the Rec icon is selected, Step, Pause, and Save icons appear in the Macro 
File tool bar.  

• The Pause icon is selected to temporarily stop recording characters. Once 
selected, a Resume icon takes its place. To resume recording, click the 
Resume icon.  

• The Step icon is used to insert a pause in the macro.  
 
When the macro file is played back, the saved keystrokes are played 
immediately without pausing. Inserting a pause after playing back some 
keystrokes forces the program to pause, allowing viewing of the screen 
before continuing. To insert a pause, click the Step icon or key in Ctrl-Enter. 

• The Save icon is used to stop recording and save the file. 
 
Recording automatically stops if a new application is selected or the VT100 
screen is left. 
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− The Play icon in the Macro File tool bar is used to play back a previously 
recorded macro file. After selecting the Play icon, enter the name of the macro 
file to be played. Once the Play icon is selected and a file name entered Step 
and Stop icons appear in the Macro File tool bar.  
 
Playback proceeds to the next pause or "step" in the file. When a pause is 
encountered, the Step icon is enabled.  

• The Step icon is used to perform the next step. When all steps in the macro 
file have been played back, playback mode is stopped automatically.  

• The Stop icon is used to end playback before the file is done. 

• The Capture Tool Bar is used to record VT100 characters as they are received from 
the equipment for display. They can also record a snapshot of the entire VT100 
window at once.  

NOTE 

Captured data must be examined using a text editor; there is no capture 
file playback in Application Explorer. 

− The Start icon located in the Capture area is used to start the capture process. 
Enter the name of the capture file. As data is received for display, it is saved in 
the file. Once the Start icon is activated, Snap, Pause, and End icons appear in 
the Capture Files tool bar. 

• The Snap icon is used to capture a snapshot of the entire VT100 window. 

• The Pause icon is used to temporarily stop recording data. Once the Pause 
icon is selected, a Resume icon takes its place on the screen. The Resume 
icon is used to resume recording. 

• To end capture, the End icon is used to end capture. 
 
Capture automatically stops if a new application is selected or the VT100 
screen is left. 

• The Status Bar at the bottom of the screen displays the current status of the macros 
and capture functions. 
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4.4.8. Communication Explorer – Network Statistics  

 

Figure 4–14. Communication Explorer – Network Statistics Screen 

The Communication Explorer – Network Statistics screen displays the Application’s 
network statistics including number of received and transmitted messages, possible 
error counts, and nodes connected. Statistics can be cleared and updated by using the 
Clear and Refresh buttons. 
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5. SECTION 5 – SYMBOLS 

5.1. GENERAL  

This section describes the symbols used in MMS layout configuration.  

5.2. PHILOSOPHY 

Each symbol has a tool bar icon used to select the symbol and an associated image 
(symbol) that appears on the layout screen. 
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5.3. ALTERNATE TRACK SYMBOLS 

The following track symbol is used to indicate non-rail traffic (i.e. bus routing): 

Toolbar Icon:    

Symbol image:   

Table 5–1. Alternate Track Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By Application

Type Track type No  Alternate Traffic 
Label Text label of 

symbol 
Yes Any Text 

(128 char. max) 
Symbol ID + "TR" 

Label 
Location 

Location of 
symbol label 

Yes Top, Bottom, Left, 
Right, Center 

Bottom 

Description Optional text 
description 

Yes Optional, Any Text
(255 char. max) 

"" 

 

Limiting Parameters – Controls 

None 

Table 5–2. Alternate Track Symbol Parameters – Indications 

Parameter State Description 

TRACK_STATUS OCCUPIED Indicates track occupancy 
If set track color = occupied 
Otherwise color = default 
Set_User_Preferences 

TRACK_STATUS BLOCKED Indicates a track is blocked from traffic 
If set track color = blocked 
OCCUPIED overrides BLOCKED 
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5.4. CODED TRACK SYMBOLS 

The following track symbol is used to indicate coded track circuits: 

Toolbar Icon:   

Symbol image:   

Table 5–3. Coded Track Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By Application

Overlay 
Tracks 

Overlay tracks 
associated with 
this track 

No   

Neighbor-
Head 

Symbol linked to 
the head end of 
this track 

No   

Neighbor-Tail Symbol linked to 
the tail end of this 
track 

No   

Type Type of Track Yes AC Coded, DC 
Coded 

DC Coded 

Loss of 
Shunt Delay 

Time to wait after 
loss of shunt  

Yes hh:mm:ss.msecs 00:00:00.000 

Entry/Exit Allow use as 
entry/exit track 

Yes Yes, No No 

Cab Signal Allow cab signal 
display 

Yes Enabled, Disabled Disabled 

Label Text label of 
symbol 

Yes Any Text 
(128 char. max) 

Symbol ID + "TR" 

Label 
Location 

Location of 
symbol label 

Yes Top, Bottom, Left, 
Right, Center 

Bottom 

Description Optional text 
description 

Yes Optional, Any Text
(255 char. max) 

"" 
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Table 5–4. Coded Track Symbol Parameters – Controls 

Parameter State Description 

ENTRY_EXIT_CALL 
(if enabled) 

ENTRY Request track as entry point in NX 
operation 

ENTRY_EXIT_CALL 
(if enabled) 

EXIT Request track as exit point in NX operation 

Table 5–5. Coded Track Symbol Parameters – Indications 

Parameter State Description 

TRACK_STATUS OCCUPIED Indicates track occupancy 
If set track color = occupied 
Otherwise color = default 

TRACK_STATUS BLOCKED Indicates a track is blocked from traffic 
If set track color = blocked 
OCCUPIED overrides BLOCKED 

TRACK_ROUTE LOCKED Indicates the track is part of a locked route 
If set track color = route 

TRACK_ROUTE POSSIBLE Indicates the track is an Entry or Exit point 
If set and Entry/Exit is Yes a mid-section of 
the track color = route 
TRACK_STATUS overrides 
TRACK_ROUTE 

EAST/WEST CODES CODE_1 thru 
CODE_9 

Indicates track codes 
EAST CODES displayed as:   code-list >> 
WEST CODES displayed as:   << code-list 
? indicates unknown code 

CAB_RATE  
(if enabled) 

RATE_1 thru 
RATE_7 

Indicates cab signal rate 
Rate index is displayed as:  [index] 
*  indicates invalid index 
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5.5. COLOR LIGHT 

The following signal symbol is used to indicate a color light: 

Toolbar Icons: ,  

Symbol image:   

Table 5–6. Color Light Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By 
Application 

Alignment East/West 
alignment 

No   

Type Type of signal No  Color Light 
Label Text label of 

symbol 
Yes Any Text 

(128 char. max) 
Symbol ID + "CL"

Label 
Location 

Location of symbol 
label 

Yes Top, Bottom, Left, 
Right 

Bottom (East), 
Top (West) 

Description Optional text 
description 

Yes Optional, Any Text 
(255 char. max) 

"" 

Head (A/B/C) Enable up to three 
heads per Color 
light 

Yes Enabled, Disabled A-Enabled  
B/C-Disabled 

Flashing Enable flashing for 
this head 

Yes Enabled, Disabled Disabled 

Flash Rate Flash rate for this 
head 

Yes 0, 
40,45,50,55,60,65 

0 

Red Aspect Enable Red 
aspect for this 
head 

Yes Enabled, Disabled Enabled 

Yellow 
Aspect 

Enable Yellow 
aspect for this 
head 

Yes Enabled, Disabled Enabled 

Green 
Aspect 

Enable Green 
aspect for this 
head 

Yes Enabled, Disabled Enabled 
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Table 5–6. Color Light Symbol Attributes (Cont.) 

Attribute Description User 
Defined 

Possible Entries Default 

Lunar Aspect Enable Lunar 
aspect for this 
head 

Yes Enabled, Disabled Disabled 

Track Select 
Aspect 

Enable Track 
Select aspect for 
this head 

Yes Enabled, Disabled Disabled 

Table 5–7. Color Light Symbol Parameters – Controls 

Parameter State Description 

ASPECT_CALL CANCEL Remove the request of permissive signal 
call 

ASPECT_CALL CALL Request for signal 
ASPECT_CALL CALL_ON Request signal for move into occupied 

territory 
ASPECT_CALL FLEET Reclear signal to allow following moves 

Table 5–8. Color Light Symbol Parameters – Indications 

Parameter State Description 

ACTIVE_ASPECT (head)_ 
(aspect color) 

Indicates aspect color for each head 

ASPECT_STATUS (head)_ 
(aspect color)_ 

OPEN 

Indicates the filament status 

FLEET  Indicates fleeting enabled 
If fleeted displays "F" in fleet color 
Otherwise no "F" displayed 

REQUEST_STATUS PENDING Indicates signal call is pending 
If pending signal border = pending color 

REQUEST_STATUS FAILED Indicates signal call has failed 
If failed signal border = failed color 
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5.6. DIRECTION INDICATOR 

The following symbol is used to indicate direction of traffic: 

Toolbar Icon:   

Symbol image:   

Table 5–9. Direction Indicator Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By Application 

Type Generic type No  Direction Indicator 
Label Text label of 

symbol 
Yes Any Text 

(128 char. max) 
Symbol ID + "Gn" 

Description Optional text 
description 

Yes Optional, Any Text
 (255 char. max) 

"" 

 

Parameters – Controls:  none 

Table 5–10. Direction Indicator Symbol Parameters – Indications 

Parameter State Description 

GENERIC_TRAFFIC DIRECTION Indicates direction of arrow 
If set arrow is pointing to the left 
Otherwise arrow is pointing to the right 

GENERIC_TRAFFIC LOCK Indicates if the direction is locked 
If locked direction indicator color = locked 
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5.7. GENERIC 

The following symbol is used for True/False control and/or indication: 

Toolbar Icon:   

Symbol image:   

Table 5–11. Generic Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By Application

Type Generic type Yes Indication only, 
Control only, 
Indication & 

Control 

Indication & 
Control 

Delay Time Active pulse time Yes hh:mm:ss.msecs 00:00:00.000 
Protect Flag Enables "Are you 

sure?" dialog on 
control 

Yes Enabled, Disabled Disabled 

Label Text label of 
symbol 

Yes Any Text 
(128 char. max) 

Symbol ID + "Gn" 

Label 
Location 

Location of 
symbol label 

Yes Top, Bottom, Left, 
Right 

Right 

Description Optional text 
description 

Yes Optional, Any Text
(255 char. max) 

"" 

Table 5–12. Generic Symbol Parameters – Controls 

Parameter State Description 

GENERIC_OUTPUT 
(if enabled) 

 True/False Control bit 

Table 5–13. Generic Symbol Parameters – Indications 

Parameter State Description 

GENERIC_INPUT 
(if enabled) 

 Indicates state of input 
If set generic color = generic indication 



Symbols 

P2509, Rev. Jan/09 5–9 Alstom Signaling Inc. 

5.8. GRADE CROSSING 

The following symbol is used to indicate the state of a grade crossing: 

Toolbar Icon:   

Symbol image:   

Table 5–14. Grade Crossing Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By 
Application 

Type Grade Crossing 
type 

No  Generic 

Loss of 
Shunt Delay 

Time to wait after 
loss of shunt  

Yes hh:mm:ss.msecs 00:00:00.000 

Label Text label of 
symbol 

Yes Any Text 
(128 char. max) 

Symbol ID + "GX"

Label 
Location 

Location of symbol 
label 

Yes Top, Bottom, Left, 
Right, Center 

Bottom 

Description Optional text 
description 

Yes Optional, Any Text 
(255 char. max) 

"" 

 

Parameters – Controls 

None 
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Table 5–15. Grade Crossing Symbol Parameters – Indications 

Parameter State Description 

CROSSING_STATUS OCCUPIED Indicates track occupancy 
If set track color = occupied 
Otherwise color = default 

CROSSING_STATUS BLOCKED Indicates a track is blocked from traffic 
If set track color = blocked 
OCCUPIED overrides BLOCKED 

CROSSING_ROUTE  Indicates the crossing is part of a locked 
route 
If set track color = route 

GATE_STATUS UP Indicates the status of the crossing gates 
If up gate is not displayed and signals are 
dark * 

GATE_STATUS DOWN Indicates the status of the crossing gates 
If down gate is displayed steady and 
signals are flashing  * 

 
* If neither GATE_STATUS.UP nor GATE_STATUS.DOWN is set then the gates and signals are flashing. 
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5.9. NON-CODED TRACK 

The following track symbol is used to indicate track circuits without codes: 

Toolbar Icon:   

Symbol image:   

Table 5–16. Non-Coded Track Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By 
Application 

Overlay 
Tracks 

Overlay tracks 
associated with 
this track 

No   

Neighbor-
Head 

Symbol linked to 
the head end of 
this track 

No   

Neighbor-
Tail 

Symbol linked to 
the tail end of this 
track 

No   

Type Type of Track Yes AC No Code,  
DC No Code 

DC No Code 

Loss of 
Shunt Delay 

Time to wait after 
loss of shunt  

Yes hh:mm:ss.msecs 00:00:00.000 

Entry/Exit Allow use as 
entry/exit track 

Yes Yes, No No 

Cab Signal Allow cab signal 
display 

Yes Enabled, Disabled Disabled 

Label Text label of 
symbol 

Yes Any Text 
(128 char. max) 

Symbol ID + "TR" 

Label 
Location 

Location of symbol 
label 

Yes Top, Bottom, Left, 
Right, Center 

Bottom 

Description Optional text 
description 

Yes Optional, Any Text 
(255 char. max) 

"" 
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Table 5–17. Non-Coded Track Symbol Parameters – Controls 

Parameter State Description 

ENTRY_EXIT_CALL 
(if enabled) 

ENTRY Request track as entry point in NX 
operation 

ENTRY_EXIT_CALL 
(if enabled) 

EXIT Request track as exit point in NX operation 

Table 5–18. Non-Coded Track Symbol Parameters – Indications 

Parameter State Description 

TRACK_STATUS OCCUPIED Indicates track occupancy 
If set track color = occupied 
Otherwise color = default 

TRACK_STATUS BLOCKED Indicates a track is blocked from traffic 
If set track color = blocked 
OCCUPIED overrides BLOCKED 

TRACK_ROUTE LOCKED Indicates the track is part of a locked route 
If set track color = route 

TRACK_ROUTE POSSIBLE Indicates the track is an Entry or Exit point 
If set and Entry/Exit is Yes a mid-section of 
the track color = route 
TRACK_STATUS overrides 
TRACK_ROUTE 

CAB_RATE  
(if enabled) 

RATE_1 thru 
RATE_7 

Indicates cab signal rate 
Rate index is displayed as   [index] 
*  indicates invalid index 
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5.10. OVERLAY TRACK 

The following track symbol is used to indicate overlay track circuits (typically placed 
over other tracks/switches): 

Toolbar Icon:   

Symbol image:   

Table 5–19. Overlay Track Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By 
Application 

Overlaid 
Symbols 

Tracks/Switches 
associated with 
this track 

No   

Type Type of Track No  Overlay 
Loss of 

Shunt Delay 
Time to wait after 
loss of shunt  

Yes hh:mm:ss.msecs 00:00:00.000 

Cab Signal Allow cab signal 
display 

Yes Enabled, Disabled Disabled 

Label Text label of 
symbol 

Yes Any Text 
(128 char. max) 

Symbol ID + "TR" 

Label 
Location 

Location of symbol 
label 

Yes Top, Bottom, Left, 
Right, Center 

Bottom 

Description Optional text 
description 

Yes Optional, Any Text 
(255 char. max) 

"" 

 

Parameters – Controls 

None 
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Table 5–20. Overlay Track Symbol Parameters – Indications 

Parameter State Description 

TRACK_STATUS OCCUPIED Indicates track occupancy 
If set track color = occupied 
Otherwise color = default 

TRACK_STATUS BLOCKED Indicates a track is blocked from traffic 
If set track color = blocked 
OCCUPIED overrides BLOCKED 

TRACK_ROUTE LOCKED Indicates the track is part of a locked route 
If set track color = route 

TRACK_ROUTE POSSIBLE Indicates the track is an Entry or Exit point 
If set and Entry/Exit is Yes a mid-section of 
the track color = route 
TRACK_STATUS overrides 
TRACK_ROUTE 

CAB_RATE  
(if enabled) 

 

RATE_1 thru 
RATE_7 

Indicates cab signal rate 
Rate index is displayed as   [index] 
*  indicates invalid index 
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5.11. POSITION LIGHT 

The following signal symbol is used to indicate a position light: 

Toolbar Icons:  ,  

Symbol image:   

Table 5–21. Position Light Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By 
Application 

Alignment East/West 
alignment 

No   

Type Type of signal No  PositionLight 
Label Text label of 

symbol 
Yes Any Text 

(128 char. max) 
Symbol ID + "PL" 

Label 
Location 

Location of symbol 
label 

Yes Top, Bottom, Left, 
Right 

Bottom (East), 
Top (West) 

Description Optional text 
description 

Yes Optional, Any Text 
(255 char. max) 

"" 

Head (A/B/C) Enable up to three 
heads per Position 
light 

Yes Enabled, Disabled A-Enabled  
B/C-Disabled 

Flashing Enable flashing for 
this head 

Yes Enabled, Disabled Disabled 

Flash Rate Flash rate for this 
head 

Yes 0, 
40,45,50,55,60,65 

0 

Red Aspect Enable Red 
aspect for this 
head 

Yes Enabled, Disabled Enabled 

Yellow 
Aspect 

Enable Yellow 
aspect for this 
head 

Yes Enabled, Disabled Enabled 

Green 
Aspect 

Enable Green 
aspect for this 
head 

Yes Enabled, Disabled Enabled 
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Table 5–21. Position Light Symbol Attributes (Cont.) 

Attribute Description User 
Defined 

Possible Entries Default 

Lunar Aspect Enable Lunar 
aspect for this 
head 

Yes Enabled, Disabled Disabled 

Track Select 
Aspect 

Enable Track 
Select aspect for 
this head 

Yes Enabled, Disabled Disabled 

Table 5–22. Position Light Symbol Parameters – Controls 

Parameter State Description 

ASPECT_CALL CANCEL Remove the request of permissive signal 
call 

ASPECT_CALL CALL Request for signal 
ASPECT_CALL CALL_ON Request signal for move into occupied 

territory 
ASPECT_CALL FLEET Reclear signal to allow following moves 

Table 5–23. Position Light Symbol Parameters – Indications 

Parameter State Description 

ACTIVE_ASPECT (head)_ 
(aspect color) 

Indicates aspect color for each head 

ASPECT_STATUS (head)_ 
(aspect color)_ 

OPEN 

Indicates the filament status 

FLEET  Indicates fleeting enabled 
If fleeted displays "F" in fleet color 
Otherwise no "F" displayed 

REQUEST_STATUS PENDING Indicates signal call is pending 
If pending signal border = pending color 

REQUEST_STATUS FAILED Indicates signal call has failed 
If failed signal border = failed color 
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5.12. REMOTE/LOCAL CONTROL 

The following signal symbol is used to indicate a remote/local control and indication: 

Toolbar Icons:   

Symbol image:   

Table 5–24. Remote/Local Control Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By 
Application 

Type Remote/Local type No  Remote/Local 
Label Text label of 

symbol 
Yes Any Text 

(128 char. max) 
Symbol ID + "Gu"

Mode 
Change 
Timeout 

Change request 
timeout 

Yes 00:00:01:000 to 
23:59:59:000 

00:00:05:000 

Table 5–25. Remote/Local Control Symbol Parameters – Controls 

Parameter State Description 

OP_MODE_CALL REMOTE 
LOCAL 

Request Remote mode 
Request Local mode 

Table 5–26. Remote/Local Control Symbol Parameters – Indications 

Parameter State Description 

OP_MODE LOCAL Indicates the operational mode 
(Remote/Local)  
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5.13. SEARCH LIGHT 

The following signal symbol is used to indicate a search light: 

Toolbar Icons:   ,  

Symbol image:   

Table 5–27. Search Light Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By 
Application 

Alignment East/West alignment No   

Type Type of signal No  Search Light 
Mech Delay Time delay for search 

light mechanism 
operation 

Yes hh:mm:ss.msecs 00:00:00.000 

Label Text label of symbol Yes Any Text 
(128 char. max) 

Symbol ID + 
"SL" 

Label 
Location 

Location of symbol 
label 

Yes Top, Bottom, Left, 
Right 

Bottom (East), 
Top (West) 

Description Optional text 
description 

Yes Optional, Any Text 
(255 char. max) 

"" 

Head 
(A/B/C) 

Enable up to three 
heads per Search light 

Yes Enabled, Disabled A-Enabled 
B/C-Disabled 

Flashing Enable flashing for this 
head 

Yes Enabled, Disabled Disabled 

Flash Rate Flash rate for this 
head 

Yes 0, 
40,45,50,55,60,65 

0 

Red Aspect Enable Red aspect for 
this head 

Yes Enabled, Disabled Enabled 

Yellow 
Aspect 

Enable Yellow aspect 
for this head 

Yes Enabled, Disabled Enabled 

Green 
Aspect 

Enable Green aspect 
for this head 

Yes Enabled, Disabled Enabled 
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Table 5–27. Search Light Symbol Attributes (Cont.) 

Attribute Description User 
Defined 

Possible Entries Default 

Lunar Aspect Enable Lunar aspect 
for this head 

Yes Enabled, Disabled Disabled 

Track Select 
Aspect 

Enable Track Select 
aspect for this head 

Yes Enabled, Disabled Disabled 

Table 5–28. Search Light Symbol Parameters – Controls 

Parameter State Description 

ASPECT_CALL CANCEL Remove the request of permissive signal 
call 

ASPECT_CALL CALL Request for signal 
ASPECT_CALL CALL_ON Request signal for move into occupied 

territory 
ASPECT_CALL FLEET Reclear signal to allow following moves 

Table 5–29. Search Light Symbol Parameters – Indications 

Parameter State Description 

ACTIVE_ASPECT (head)_ 
(aspect color) 

Indicates aspect color for each head 

ASPECT_STATUS (head)_OPEN Indicates the filament status 
REPEATER_STATUS (head)_ 

(aspect color) 
Indicates repeater status for each aspect of 
each head 

FLEET  Indicates fleeting enabled 
If fleeted displays "F" in fleet color 
Otherwise no "F" displayed 

REQUEST_STATUS PENDING Indicates signal call is pending 
If pending signal border = pending color 

REQUEST_STATUS FAILED Indicates signal call has failed 
If failed signal border = failed color 
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5.14. SEMAPHORE LIGHT 

The following signal symbol is used to indicate a semaphore light: 

Toolbar Icons:  ,  

Symbol image:   

Table 5–30. Semaphore Light Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By 
Application 

Alignment East/West 
alignment 

No   

Type Type of signal No  Semaphore Light 
Label Text label of 

symbol 
Yes Any Text 

(128 char. max) 
Symbol ID + "PL" 

Label 
Location 

Location of symbol 
label 

Yes Top, Bottom, Left, 
Right 

Bottom (East), 
Top (West) 

Description Optional text 
description 

Yes Optional, Any Text 
(255 char. max) 

"" 

Head (A) Enable 
Semaphore light 
head 

Yes Enabled, Disabled Enabled 

  Flashing Enable flashing for 
this head 

Yes Enabled, Disabled Disabled 

    Flash 
Rate 

Flash rate for this 
head 

Yes 0, 
40,45,50,55,60,65 

0 

 
* Always contains Red, Yellow, Green and Lunar aspects. 
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Table 5–31. Semaphore Light Symbol Parameters – Controls 

Parameter State Description 

ASPECT_CALL CANCEL Remove the request of permissive signal 
call 

ASPECT_CALL CALL Request for signal 
ASPECT_CALL CALL_ON Request signal for move into occupied 

territory 
ASPECT_CALL FLEET Reclear signal to allow following moves 

Table 5–32. Semaphore Light Symbol Parameters – Indications 

Parameter State Description 

ACTIVE_ASPECT A_(aspect color) Indicates aspect color 
ASPECT_STATUS A_(aspect 

color)_   OPEN 
Indicates the filament status 

FLEET  Indicates fleeting enabled 
If fleeted displays "F" in fleet color 
Otherwise no "F" displayed 

REQUEST_STATUS PENDING Indicates signal call is pending 
If pending signal border = pending color 

REQUEST_STATUS FAILED Indicates signal call has failed 
If failed signal border = failed color 
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5.15. SWITCH 

The following symbol is used to indicate a switch. 

Toolbar Icons:   ,  ,  ,  

Symbol image:   

Table 5–33. Switch Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By 
Application 

Overlay 
Tracks 

Overlay tracks 
associated with 
this switch 

No   

Neighbor-
Facing 

Symbol linked to 
the facing end of 
this switch 

No   

Neighbor-
Trailing 

Symbol linked to 
the trailing end of 
this switch 

No   

Neighbor-
Reverse 

Symbol linked to 
the reverse end of 
this switch 

No   

Alignment Alignment of 
switch 

No   

Type Type of Switch Yes Generic Generic 
Switch 
Delay 

Time to wait for 
switch operation  

Yes hh:mm:ss.msecs 00:00:00.000 

Label Text label of 
symbol 

Yes Any Text 
 (128 char. max) 

Symbol ID + "SW"

Label 
Location 

Location of symbol 
label 

Yes Top, Bottom, Left, 
Right, Center 

Center 

Description Optional text 
description 

Yes Optional, Any Text 
(255 char. max) 

"" 
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Table 5–34. Switch Symbol Parameters – Controls 

Parameter State Description 

POSITION_CALL NORMAL Request switch position to normal 
POSITION_CALL REVERSE Request switch position to reverse 
POSITION_CALL AUTOMATIC Request application to determine switch 

position based on routing 

Table 5–35. Switch Symbol Parameters – Indications 

Parameter State Description 

POSITION NORMAL Indicates switch position is normal (facing 
end to trailing end solid line) 

POSITION REVERSE Indicates switch position is reverse (facing 
end to reverse end solid line) 

CONTROL NORMAL Indicates switch is going normal 
CONTROL REVERSE Indicates switch is going reverse 

LOCK_STATUS  Indicates switch locking 
If locked displays "L" in locked color 
Otherwise displays "U" in default color 

REQUEST_STATUS PENDING Indicates position call is pending 
Switch flashes in direction of CONTROL 
If CONTROL is unknown entire switch 
flashes 

REQUEST_STATUS FAILED Indicates position call has failed 
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5.16. TEXT BOX 

The following symbol used to provide a text box to display text: 

Toolbar Icon:   

Symbol image:   

Table 5–36. Text Box Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By Application

Type Text box type Yes Static, Numeric Static 
Label Text label of 

symbol 
Yes Any Text 

(128 char. max) 
Symbol ID + "TB" 

Font Size Size of symbol 
label 

Yes 10 pt, 12 pt, 14 pt, 
16 pt, 20 pt, 28 pt, 

36 pt, 48 pt 

10 pt 

 

Parameters – Controls 

None 

Table 5–37. Text Box Symbol Parameters – Indications 

Parameter State Description 

TEXTBOX_VALUE  
(if type is dynamic) 

BIT_1 thru 
BIT_8 

Displays a byte length number 
Number displayed is decimal format (0 .. 
255) 
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5.17. TIMER 

The following symbol is used to indicate timer: 

Toolbar Icon:   

Symbol image:   

Table 5–38. Timer Symbol Attributes 

Attribute Description User 
Defined 

Possible Entries Default 

Symbol ID ID number of the 
symbol 

No  Set By Application

Type Text box type Yes Generic Generic 
Delay Time Running time of 

timer 
Yes hh:mm:ss.msecs 00:00:00.000 

Label Text label of 
symbol 

Yes Any Text 
(128 char. max) 

Symbol ID + "TM" 

Label 
Location 

Location of 
symbol label 

Yes Top, Bottom, Left, 
Right 

Bottom 

Description Optional text 
description 

Yes Optional, Any Text
(255 char. max) 

"" 

 

Parameters – Controls 

None 

Table 5–39. Timer Symbol Parameters – Indications 

Parameter State Description 

TIMER_STATUS START Indicates timer is starting 
TIMER_STATUS RUNNING Indicates timer is running 

If running timer = running color 
TIMER_STATUS DONE Indicates time delay has expired 
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A. APPENDIX A – COMMUNICATIONS 

A.1. GENERAL 

This section contains block diagrams describing MMS communications.  

A.2. SYSTEM STATUS AND DIAGNOSTIC SERIAL CONNECTION PROCESSING 

Start

Enable Status Poll 
Timer

Watchdog = Armed

Query System Status

Watchdog = Active

Log New System Status

Query Diagnostic

Return

End Of 
Diagnostics

Watchdog = Active

Log New Diagnostic

Query Next

Return

Process 
Status / Diagnostic 

Response

Status = OK

Status = 
WARNING/

ERROR

Return

yes

no

yes

no

yes

no

 

Figure A–1. System Status and Diagnostic Processing 
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Status Poll Timer
(10 seconds)

Disable

System 
Status Known

Return Start

Watchdog Timer
(15 seconds)

Watchdog 
Active

Watchdog = Armed

Return

3 Tries

Increment TriesSystemStatus = 
Unknown

Tries = 0

Start

Return

yes

no

yesno

yes no

 

Figure A–1. System Status and Diagnostic Processing (Cont.) 
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A.3. PANEL MESSAGE PROCESSING 

A.3.1. DataTrain VIII Sync Message Processing 

DataTrain VIII communications between MMS Runtime and VPI use Sync mode with 
networked connections and can use Sync mode with serial connections. Message 
retries are fixed at 3 tries.  

Start

QuerySync

Return

Wait 100ms

Enable Sync timer

Sync Timer 
Expired

Disable Sync Timer

Send Poll

Wait For 
Response

Response 
Valid

3 Tries

Increment Tries

Response 
Bitmap

no

Tries = 0

Log Changes

Display Changes

Send Controls

Wait For 
Response

Response 
Valid

Return

Tries = 0

3 Tries

Issue Timeout Error

Increment Tries

Return

Issue Timeout Error

yes
noyes

no yes

no yes

no yes

 

Figure A–2. DataTrain VIII Sync Message Processing 
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Process Sync 
Response

Indication

Poll

Log Changes

Display Changes

Send Controls

Wait For 
Response

Response 
Valid

Return

Tries = 0

3 Tries

Issue Time Out 
Error

Increment Tries

no yes

no yes

no yes

no yes

 

Figure A–2. DataTrain VIII Sync Message Processing (Cont.) 
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A.3.2. DataTrain VIII Master/Slave Message Processing 

DataTrain VIII communications between MMS Runtime and VPI use Sync can use 
Master/Slave mode with MMS Runtime as the Master on serial connections. The default 
poll time is 250 ms, response timeout is 100 ms. Message retries are fixed at 3 times. 

Start

Enable Poll Timer

Return

Poll Timer

Disable

Query Poll

Response 
OK

Log Changes

Display Changes

3 Tries

Port = Off-Line

Suspend For 10 Poll 
Cycles

Increment Tries

Tries = 0

Control 
Pending

Send

Response 
OK

Return

Clear Pending

ReturnReturn

Wait For 
Response

Wait For 
Response

Wait For 
Response

Enable Response 
Timer

Response
VERIFIED

Return (OK)
Response Timer

Expired

Return (Timeout)

no yes

no yes

no yes

no yes

no yes

no yes

 

Figure A–3. DataTrain VIII Master/Slave Message Processing  
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A.4. DATA LOG RETRIEVAL PROCESSING 

Data log retrieval use DataTrain VIII communications in a multi-drop Master/Slave mode 
with MMS Runtime as the Master. There is no cycled polling; default response timeout 
is 250 ms. Message fixed at 3 tries. 

Query Log Record

Response
OK

Save In MMS Log

3 Tries

Issue Error Increment Tries

Tries = 0

Abort

New Log 
Record

End Of Log

Next Record

Return

Start

Wait For 
Response

Enable
ResponseTimer

Response
VERIFIED

Response Timer
Expired

Return (OK)

Return (Timeout)

Wait for Response

yes no

yes no

yes no

yesno

yesno

yesno

yesno

 

Figure A–4. Data Log Retrieval Processing 



 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FOR QUESTIONS AND INQUIRIES, CONTACT CUSTOMER SERVICE AT 
1-800-717-4477 

OR 
WWW.ALSTOMSIGNALINGSOLUTIONS.COM 

 
 

ALSTOM SIGNALING INC.  
1025 JOHN STREET 

WEST HENRIETTA, NY 14586 


